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Documentation Updates 

This guide’s title page contains the following identifying information: 

• Software Version number, which indicates the software version. 

• Document Release Date, which changes each time the document is updated. 

• Software Release Date, which indicates the release date of this version of the software.


To check for recent updates, or to verify that you are using the most recent edition of a document, go to:


http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign-in. To register for an HP Passport ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page. 

You will also receive updated or new editions if you subscribe to the appropriate product support service. 
Contact your HP sales representative for details. 
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Support 

You can visit the HP Software Support Online web site at: 

http://www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and support that HP 
Software offers. 

HP Software Support Online provides customer self-solve capabilities. It provides a fast and efficient way to 
access interactive technical support tools needed to manage your business. As a valued support customer, you 
can benefit by using the HP Software Support web site to: 

• Search for knowledge documents of interest


• Submit and track support cases and enhancement requests


• Download software patches


• Manage support contracts


• Look up HP support contacts


• Review information about available services


• Enter into discussions with other software customers


• Research and register for software training


Most of the support areas require that you register as an HP Passport user and sign in. Many also require a

support contract.


To find more information about access levels, go to:


http://h20230.www2.hp.com/new_access_levels.jsp 

To register for an HP Passport ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 
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1 Overview 

This chapter introduces the following topics: 

• PI and frame relay interfaces 

• New features in version 4.20 

• Brief overview of the generic reports 

• Data collection 

• Integration with NNM 

• Ways to customize reports 

• Sources for additional information 

PI and Frame Relay Interfaces 

Performance Insight is a performance management application that collects data from many 
sources, performs in-depth trend analysis, maintains performance baselines, and provides 
users with convenient, web-based reporting. Following is a partial list of PI features: 

• Distributed architecture 

• Easy to scale (supports data collection from thousands of agents) 

• CODA/PA agent support 

• Multi-company security model 

• Data warehousing 

• Near Real Time reporting 

• Forecasting 

• Extensive aggregation (by day, week, month; by location, by customer) 

• Thresholding and alerting 

• Easy identification of bottlenecks 

• Easy assessment of capacity trends 

• Accurate and timely documentation for management 

• Integration with NNM and HP Operations/OM 

Frame relay networks eliminate link-layer error checking by assigning responsibility for 
packet retransmission to higher level protocols. To avoid congestion, the nodes in a frame 
relay network forward flow-control alerts to neighboring nodes. If flow-control alerts do not 
prevent congestion, nodes can alter the discard-eligibility (DE) status of individual frames. 
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The Frame Relay Report Pack installs on PI. Installing the Frame Relay Report Pack creates 
one parent directory and two child directories. The parent directory is FrameRelay_Service. 
The child directories are: 

• Port 

• PVC 

Reports in the port folder display data for the logical port on the device, which usually equates 
to an entry in the MIB-II ifTable. Reports in the port folder track the following statistics: 

• In utilization/out utilization 

• Number of frames sent/number of frames received 

• Number of octets sent/number of octets received 

• Number of frames discarded 

• Number of frames discarded due to errors 

Reports in the PVC folder reach a lower level of detail, showing information for PVC 
endpoints. Reports in the PVC folder track the following statistics: 

• Ingress utilization/egress utilization 

• Number of committed-burst frames 

• Number of excess-burst frames 

• Number of Discard Eligible (DE) frames 

• Number of frames indicating forward congestion (FECN) 

• Number of frames indicating backward congestion (BECN) 

Enhancements in Version 4.20 

Version 4.20 includes new features, a new upgrade package, and defect fixes. In addition, 
there are new versions of the datapipes that collect data for Frame Relay. (For details about 
the enhancements that were made to previous releases of Frame Relay, see Appendix A, 
Version History. 

New Features 

• Copy Policy Enhancement 

New Upgrade Package 

• FrameRelay_Service_Upgrade_30_to_42 

Defect Fixes 

•	 QXCR1000843112 - pvc.montlyquickview.rpt report bottom Egress report shows December 
1969 date 
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Generic Reports 

The Frame Relay Report Pack contains the following types of reports: 

Availability. Highlights ports and PVCs reporting low availability for yesterday. The 
selection table is followed by hourly analysis of availability for a selected port or PVC. 

Capacity Planning. Highlights Ports and PVCs that are expected to be either underutilized 
or overutilized 30 days from now. 

Executive Summary/Executive Summary by Region. A comparison of baseline 
performance to F30 for all ports or all PVCs, followed by monthly, daily, and hourly analysis of 
aggregated volume and aggregated errors. The report begins with either a list of customers or 
a list of regions. 

Forecast. Highlights ports and PVCs that are expected to have the highest utilization levels 
30 days into the future. Rate of growth is calculated by dividing the F30 value by the baseline 
average. The baseline average is an average of daily busy hour values. 

Hot Spots. Highlights ports and PVCs with high exceptions. The PVC version looks at 
utilization, congestion, and GOS exceptions; the port version looks at utilization, error, and 
discard exceptions. 

PVC Configuration Problems. A list of PVCs that have invalid (missing or incorrect) CIR 
values or invalid PVC Id values. Any PVC with a CIR value of NULL or 0 will appear in this 
report. 

QuickView: Near Real Time, Daily, Monthly. A list of overutilized ports and PVCs, 
followed by analysis of average and peak utilization for a specific port or PVC. The NRT 
version provides a list of the most utilized ports and PVCs based on data collected (and 
averaged) over the last six hours. The selection table is followed by (1) analysis of peak and 
average utilization, (2) analysis of errors and discards, and (3) Grade of Service. 

Round Trip Delay. One version only of this report, for PVCs. Provides a list of PVCs 
experiencing the longest round trip delay. Not all datapipes collect this metric. See the release 
notes for the datapipe for details. 

Snapshot: Near Real Time, Daily, Monthly. Same as the QuickView, but limited in scope 
to specific ports or PVCs that you select in advance before the report opens. 

Top Ten. Identifies PVC endpoints and ports experiencing high utilization. Consists of two 
tables. The top table looks at yesterday’s performance; the bottom table looks at performance 
for the previous 30 days. 

Data Collection 

Installing at least one datapipe for Frame Relay is mandatory. You may install any of the 
following datapipes: 

• Frame Relay CPE Datapipe (for MIBs compliant with RFC2115) 

• Ascend Frame Relay Datapipe (Lucent) 

• Newbridge Frame Relay Datapipe (Alcatel) 

• Stratacom Frame Relay Datapipe (Cisco WAN) 
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The datapipe for Newbridge and the datapipe for Stratacom require pre-processing. If you 
intend to poll Newbridge devices, installing the Newbridge Preprocessor is mandatory. If you 
intend to poll Stratacom devices, installing the Stratacom Preprocessor is mandatory. 

The Frame Relay CPE Datapipe polls the following MIBs: 

• RFC 1315 

• Cisco Frame Relay MIB 

• Nortel/Bay FRSW MIB 

• Nortel/Bay WAN780 MIB 

The Frame Relay CPE Datapipe can be configured. For details about options for data filtering, 
property provisioning, logging, and polling policies, refer to the Frame Relay CPE Datapipe 
User Guide. 

The Requirement for Interface Reporting 

The Interface Reporting Report Pack is a prerequisite for Frame Relay. If you are not already 
using Interface Reporting, you must install Interface Reporting when you install Frame 
Relay. When you install Interface Reporting, you are not required to install the IR ifEntry 
Datapipe. However, if you want to collect raw data, and use the reports in Interface Reporting, 
then you must install the IR ifEntry Datapipe. 

The dependency on Interface Reporting is related to a property table created by Interface 
Reporting. The property table is KIRDevPorts. This table is populated by collections 
associated with Interface Reporting and collections associated with the Frame Relay Report 
Pack. The data in this table can be modified by importing properties or by working with 
change forms. 

Double-Polling Port Statistics 

If your PI server is already running raw collections for the Interface Reporting Report Pack 
(because you installed the IR ifEntry Datapipe along with the Interface Reporting Report 
Pack), and you install Frame Relay, you could be directing PI to collect port statistics twice, 
once for Interface Reporting and once for Frame Relay. If you install the Frame Relay CPE 
Datapipe, PI will collect port statistics twice; if you do not install the Frame Relay CPE 
datapipe (because you are using one of the vendor-specific datapipes instead), PI will collect 
port statistics once. 

If you are using the IR ifEntry Datapipe and the Frame Relay CPE Datapipe, you can avoid 
double-polling by using Polling Policy Manager to disable the collections for frame relay ports. 
If you disable the collections for frame relay ports, consider undeploying the reports in the 
ports folder as well, since these reports will always be empty anyway. Redeploying port 
reports later is easy, if you change your mind. 

Integration with NNM 

If your PI server and your NNM server are integrated, the NNM operator can open Frame 
Relay reports directly from NNM. Frame Relay reports will be listed in the Report Launchpad 
window. 

You can derive additional benefits from integration NNM and PI by installing the thresholds 
sub-package that comes with Frame Relay. The file name is FrameRelay_Service_Thresholds. 
Installing this package configures PI to: 
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• Monitor the database for breach and clear conditions 

• Send threshold traps (breach and clear) to NNM 

Threshold traps delivered to NNM become alarms in the NNM alarm browser. By selecting 
the alarm, the NNM operator can launch a Near Real Time report. Installing the thresholds 
sub-package enables the following default thresholds 

Exception Default Value An Exception Occurs When Severity 

DE in Deviation 10% above the 
average for yesterday 

The percentage of packets marked 
DE is 10% above yesterday’s 
average DE ratio. 

Medium 

DE out Deviation 10% above the 
average for yesterday 

The percentage of packets marked 
Discard Eligible (DE) is 10% above 
yesterday’s average DE ratio. 

Medium 

FECN% Inbound 10% The ratio of inbound packets 
marked FECN to the total number 
of packets is equal to or greater than 
10%. 

Medium 

FECN% 
Outbound 

10% The ratio of outbound packets 
marked FECN to the total number 
of packets is equal to or greater than 
10%. 

Medium 

BECN% Inbound 10% The ratio of inbound packets 
marked BECN to the total number 
of packets is equal to or greater than 
10%. 

Medium 

BECN% 
Outbound 

10% The ratio of outbound packets 
marked BECN to the total number 
of packets is equal to or greater than 
10%. 

Medium 

The threshold values in the preceding table can be modified. For details, see Chapter 5, 
Updating Property Values. 

Ways to Customize Reports 

You can customize reports by doing the following: 

• Adding property values to PVCs 

• Applying group filters to the database 

• Applying constraints to reports 

• Changing view options for tables and graphs 

For details about adding property values, and modifying property values by using a change 
form or the property import file, see Chapter 5, Updating Property Values. For details about 
view options for tables and graphs, see Appendix B, Editing Tables and Graphs. 
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Group Filters 

If you want to share your reports with customers, you have to configure PI to produce 
customer-specific reports. Here is an overview of the steps involved: 

• Use Common Property Tables to add customers and locations 

• Create a group account for all of the users affiliated with each customer 

• Create a group filter for each group account


For more information about group filters, refer to the PI Administration Guide.


Applying Constraints 

When you edit a parameter, you apply a constraint. The constraint eliminates data you are 
not interested in seeing. If you edit the Customer Name parameter, data for all customers 
except the customer you typed in the Customer Name field will drop from the report. If you 
edit the Device Name parameter, data for all devices except the device you typed in the Device 
Name field will drop from the report. 

You can apply multiple constraints at once. Frame Relay supports the following parameters: 

• Customer Name 

• Customer ID 

• Location Name 

• Location ID 

• Device Name 

• Port 

• Dlci 

• Make 

• Model 

If you are using the Web Access Server to view reports, edit parameters by clicking the Edit 
Parameters icon at the bottom right-hand corner of the report. When the Edit Parameters 
window opens, enter the constraint in the field and click Submit. 

If you are using Report Viewer, select Edit > Parameter Values from the menu bar. When the 
Modify Parameter Values window opens, click the Current Value field. Type a new value and 
click OK. 

Sources for Additional Information 

This manual includes samples of some of the reports in Frame Relay. The demo package that 
comes with Frame Relay contains a sample of every report in the package. If you have access 
to the demo package and you want to know what fully-populated reports look like, install the 
demo package. Like real reports, demo reports are interactive. Unlike real reports, demo 
reports are static. 

The following documents are related to this manual: 

• Frame Relay CPE Datapipe User Guide 
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• Interface Discovery Datapipe User Guide 

• Newbridge Preprocessor User Guide 

• NNM/PI Integration Module User Guide 

• Stratacom Preprocessor User Guide 

• Thresholds Module User Guide 

• PI Report Packs, Release Notes, February 2009 

Manuals for the core product, PI, and manuals for the reporting solutions that run on PI, can 
be downloaded from the following web site: 

http://h20230.www2.hp.com/selfsolve/manuals 

The user guides for PI are listed under Performance Insight. The user guides for report packs 
and datapipes are listed under Performance Insight Reporting Solutions. 

The manuals listed under Performance Insight Report Packs indicate the month and year of 
publication. If a manual is revised and reposted, the date will change. Since we post revised 
manuals on a regular basis, be sure to compare the date on your PDF to the date of the web 
edition and download the web edition if it is newer. 
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2 Upgrading the Report Pack

This chapter covers the following topics: 

• Guidelines for a Smooth Upgrade 

• Upgrading to Frame Relay 4.20 

• Post-Upgrade Steps 

Guidelines for a Smooth Upgrade 

The report pack CD has the latest report packs and datapipes. When you insert the report 
pack CD and launch the package extraction program, the install script extracts every package 
from the CD and copies the results to the Packages directory on your system. After the extract 
process finishes, the install script prompts you to start Package Manager. Before using 
Package Manager, review the following guidelines. 

Software Prerequisites 

Frame Relay requires the following software: 

• PI 5.40 

• All available service packs for the version of PI (5.40) you are running 

• Common Property Tables 3.90 

• Interface Reporting Report Pack 5.50 

• At least one of the following datapipes: 

— Frame Relay CPE Datapipe (FRSCPE_Datapipe) 

— Ascend Frame Relay Datapipe 

— Newbridge Frame Relay Datapipe 

— Stratacom Frame Relay Datapipe 

Common Property Tables 

If you are running an earlier version of Common Property Tables, version 3.70 or earlier, 
upgrade to version 3.90 before you upgrade the Frame Relay Report Pack. Do not install other 
packages at the same time. Install the upgrade package for Common Property Tables and only 
the upgrade package for Common Property Tables. If you need help installing the upgrade, or 
if you want to know more about how this package operates, refer to the Common Property 
Tables User Guide. 
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Datapipes and Remote Pollers 

If you uninstall an existing datapipe, the following information is lost: 

• Single polling policy for a remote poller 

• Cloned polling policies for multiple remote pollers 

• Customized polling groups 

To prevent this information from being lost, you can use the following commands to export 
existing polling policy configurations and customized polling groups: 

• collection_manager 

• group_manager 

Exporting Polling Policy Configurations 

If your environment contains polling policies for remote pollers, use the collection_manager 
command to export existing policy configurations to a file. 

UNIX: As user trendadm, run the following command: 

cd $DPIPE_HOME 

./bin/collection_manager -export -file /tmp/savePollingPolicy.lst 

Windows: As Administrator, launch a command window. Navigate to the PI install directory 
and run the following command: 

bin\collection_manager -export -file \temp\savePollingPolicy.lst 

Exporting Polling Group Configurations 

If your environment contains customized polling groups, use the group_manager command to 
export groups to individual .xml files. 

UNIX: As user trendadm, run the following command: 

cd $DPIPE_HOME 

./bin/group_manager -export_all -outfile /tmp/savePollingGroups 

Windows: As Administrator, launch a command window, then navigate to the PI install 
directory and run the following command: 

bin\group_manager -export_all -outfile \temp\savePollingGroups 

Custom Table Views 

If you created custom table views, the views you created may interfere with the report pack 
upgrade process, causing the upgrade to fail. Whether or not your custom table views 
interfere with the upgrade depends on how you created them. If you created them using SQL, 
the upgrade will succeed but your custom views will not be available once the upgrade is 
complete. If you created them using Datapipe Manager, the upgrade is likely to fail. To 
prevent the upgrade from failing, delete your custom table views before upgrading the report 
pack, then recreate them after the upgrade is complete. 
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Distributed Environments 

Upgrading packages in a distributed environment is more complicated than upgrading 
packages on a stand-alone server. Follow these steps: 

•	 Verify that every server is using the same version of PI and all available service packs. 

•	 Disable trendcopy on the central server. 

•	 Upgrade the report pack on the central server. 

•	 Configure the central server. 

•	 At each satellite server: 

—	 Install the upgrade package for the report pack 

—	 Uninstall and reinstall upgraded datapipes (if any) 

—	 Configure each satellite server 

• Re-enable trendcopy of the central server.


For details, see Chapter 4, Setting Up a Distributed System.


Upgrading to Frame Relay 4.20 

Perform the following tasks to upgrade to Frame Relay 4.20: 

•	 Task 1: Stop OVPI Timer and extract packages from the report pack CD 

•	 Task 2: If necessary, upgrade to Common Property Tables 3.90 

•	 Task 3: Upgrade to Frame Relay 4.20 

•	 Task 4: Remove the FRSCPE, Ascend, Newbridge, and/or Stratacom Datapipes (if 
installed) 

•	 Task 5: Install the FRSCPE, Ascend, Newbridge, and/or Stratacom Datapipes 

•	 Task 6: Restart OVPI Timer 

Task 1: Stop OVPI Timer and extract packages from the report pack CD 

1	 Log in to the system. On UNIX® systems, log in as root. 

2	 Stop OVPI Timer and wait for processes to terminate.


On Windows, do the following:


a	 Select Control Panel > Administrative Tools > Services 

b	 Select OVPI Timer from the list of services. 

c From the Action menu, select Stop.


On UNIX, as root, do one of the following:


—	 HP-UX: sh /sbin/init.d/ovpi_timer stop 

—	 Sun: sh /etc/init.d/ovpi_timer stop 

3 Insert the report pack CD in the CD-ROM drive. 

Windows: The Main Menu automatically displays. 
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UNIX: 

a	 Mount the CD (if the CD does not mount automatically). 

b	 Navigate to the top level directory on the CD. 

c Run ./setup 

4 Type 1 in the choice field and press Enter. The install script displays a percentage 
complete bar. When the copy is complete, the install script starts Package Manager. The 
Package Manager welcome window opens. 

Task 2: If necessary, upgrade to Common Property Tables 3.90 

The Frame Relay Report Pack requires Common Property Tables. If you are already running 
the latest version, version 3.90, skip this task. If you are running an earlier version of Common 
Property Tables, upgrade to the latest version by installing the upgrade package. When 
Package Manager confirms that the install is complete, click Done to return to the 
Management Console. 

Task 3: Upgrade to Frame Relay 4.20 

1 Start Package Manager. The Package Manager Welcome window opens.


2 Click Next. The Package Location window opens.


3 Click Install. Approve the default installation directory or select a different directory if 

necessary. 

4	 Click Next. The Report Deployment window opens. Type your username and password for 
the PI Application Server. 

5	 Click Next. The Package Selection window opens. Click the check box for the upgrade 
package you require: FrameRelay_Service_Upgrade_30_to_42. 

6	 Click Next. The Type Discovery window opens. Accept the default and click Next. The 
Selection Summary window opens. 

7	 Click Install. The Installation Progress window opens. When installation finishes, a 
package install complete message appears. 

8	 Click Done to return to the Management Console. 

Task 4: Remove the FRSCPE, Ascend, Newbridge, and/or Stratacom Datapipes (if installed) 

If the FRSCPE, Ascend, Newbridge, or Stratacom Datapipes are not installed on your system, 
go to Task 6. 

The FRSCPE, Ascend, Newbridge, and Stratacom Datapipes cannot be upgraded. You must 
remove the FRSCPE Ascend, Newbridge, and Stratacom Datapipes (if installed), then install 
the newer version of the FRSCPE, Ascend, Newbridge, and/or Stratacom Datapipes. Start 
Package Manager and follow the on-screen instructions for package removal. When Package 
Manager tells you that removal is complete, click Done to return to the Management Console. 

Task 5: Install the FRSCPE, Ascend, Newbridge, and/or Stratacom Datapipes 

1 Start Package Manager. The Package Manager welcome window opens. 

2 Click Next. The Package Location window opens. 

3 Click Install. 

4 Click Next. The Report Deployment window opens; disable the default for Deploy Reports. 

5 Click Next. The Package Selection window opens. 
20	 Chapter 2 



6 Click the check box next to the following package: 

FRSCPE Datapipe 4.3


Ascend FR Datapipe 4.1


Newbridge FR Datapipe 4.1


Stratacom FR Datapipe 4.1


7 Click Next. The Type Discovery window opens. 

8 Click Next. The Selection Summary window opens. 

9 Click Install. The Installation Progress window opens and the install begins. When the 
install finishes, the package installation complete message appears. 

10 Click Done. 

Task 6: Restart OVPI Timer 

On Windows, do the following: 

1 Select Control Panel > Administrative Tools > Services 

2 Select OVPI Timer from the list of services.


3 From the Action menu, select Start.


On UNIX, as root, do one of the following:


• HP-UX: sh /sbin/init.d/ovpi_timer start 

• Sun: sh /etc/init.d/ovpi_timer start 

Post-Upgrade Steps 

If you deleted any custom table views before you upgraded the report pack, you can recreate 
those custom views now. 
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3 Installing the Report Pack

This chapter covers the following topics: 

• Guidelines for a smooth installation 

• Installing and Tuning Frame Relay 

• Removing Frame Relay 

Guidelines for a Smooth Installation 

A PI reporting solution has at least two ingredients, a report pack and a datapipe. Some 
reporting solutions offer multiple datapipes. By installing the datapipe, you configure PI to 
collect performance data at a specific interval. By installing the report pack you configure PI 
to summarize and aggregate the data collected by the datapipe. 

When you insert the report pack CD in the CD-ROM drive and launch the package extraction 
program, the install script extracts every package from the CD and copies the results to the 
Packages directory on your system. After the extract finishes, the install script prompts you to 
launch PI and start Package Manager. Before using Package Manager, review the following 
guidelines. 

Software Prerequisites 

The Frame Relay Report Pack has the following prerequisites: 

• PI 5.40 

• All the Service Pack available for the version of PI (5.40) you are running 

• Common Property Tables 

• Interface Reporting Report Pack 

• At least one of the following datapipes: 

— Frame Relay CPE Datapipe (FRSCPE_Datapipe) 

— Ascend Frame Relay Datapipe 

— Newbridge Frame Relay Datapipe 

— Stratacom Frame Relay Datapipe 

Interface Reporting Report Pack 

Although Interface Reporting is a prerequisite for the Frame Relay Report Pack, you are not 
required to collect raw data for Interface Reporting. If you want to collect raw data for 
Interface Reporting, install the IR ifEntry Datapipe when you install Interface Reporting. In 
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addition to installing the IR ifEntry Datapipe, you will need to configure Interface Reporting 
for optimal SNMP polling and tune the report pack by deactivating any ifTypes you are not 
interested in. Both steps are covered in the latest edition of the Interface Reporting Report 
Pack User Guide. 

Preprocessors for Vendor-Specific Datapipes 

If you are polling Newbridge devices, you must install the Newbridge Preprocessor in addition 
to the packages listed above. If you are polling Stratacom devices, you must install the 
Stratacom Preprocessor in addition to the packages listed above. Each preprocessor has its 
own user guide. 

Common Property Tables 

The Frame Relay Report Pack requires Common Property Tables version 3.90. If you are not 
running any version of Common Property Tables, let Package Manager install the correct 
version for you. If you are running Common Property Tables 3.70 or earlier, you must upgrade 
to version 3.90. Do this before installing the Frame Relay Report Pack. 

FrameRelay_Service_Thresholds 

If your PI server is integrated with NNM, you should install the optional thresholds 
sub-package. The thresholds sub-package configures PI to monitor the database for threshold 
conditions. When a threshold is breached, PI will respond by taking an action. The default 
action is to send a threshold trap to your NNM server. 

You have the option of setting thresholds for rate data only, for rate data and aggregated data, 
or just for aggregated data. If Frame Relay will be operating in a distributed environment, 
and you are setting thresholds for rate data only, you must install the thresholds sub-package 
on each satellite server. If you want to set thresholds on aggregated data (for example, a 
forecast), you must install the thresholds sub-package on the central server as well as the 
satellite servers. 

If you select the thresholds sub-package for installation, Package Manager will automatically 
select and install the Thresholds Module. The Thresholds Module controls the actions that PI 
can take in response to a threshold condition. For information about modifying category, 
severity, and destination parameters, refer to the Thresholds Module User Guide. 

Distributed Environments 

Package installation in a distributed environment is more complicated than package 
installation on a stand-alone system. Following is an overview of the procedure for installing 
Frame Rely in a distributed environment: 

• Make sure PI 5.40 is installed on the central server and on every satellite server. 

• Disable trendcopy on the central server. 

• Install the following packages on the central server: 

— Common Property Tables; deploy forms 

— Interface Reporting; deploy reports 

— Frame Relay; deploy reports 
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•	 Install the following packages on each satellite server: 

—	 Common Property Tables 

—	 Interface Reporting 

—	 Frame Relay 

—	 FrameRelay_Service_Thresholds (sub-package that comes with Frame Relay) 

—	 At least one datapipe 

•	 Re-enable trendcopy of the central server. 

•	 Configure your central and satellite servers. For details, see Chapter 4, Setting Up a 
Distributed System. 

Installing and Tuning Frame Relay 

Perform these tasks to install the Frame Relay Report Pack on a stand-alone server: 

•	 Task 1: Stop OVPI Timer and extract packages from the report pack CD. 

•	 Task 2: If necessary, upgrade to Common Property Tables 3.90 

•	 Task 3: Install the report pack and at least one datapipe 

•	 Task 4: If desired, de-activate port polling policies 

•	 Task 5: If desired, adjust the polling interval to verify collections 

•	 Task 6: Restart OVPI Timer and start polling 

•	 Task 7: Provision CIRs 

•	 Task 8: If necessary, override the customer and location inherited from the interface 

•	 Task 9: Export property data from PI for safekeeping 

Task 1: Stop OVPI Timer and extract packages from the report pack CD 

1 Log in to the system. On UNIX® systems, log in as root.


2 Stop OVPI Timer and wait for processes to terminate.


On Windows, do the following:


a	 Select Control Panel > Administrative Tools > Services 

b Select OVPI Timer from the list of services.


c From the Action menu, select Stop.


On UNIX, as root, do one of the following:


—	 HP-UX: sh /sbin/init.d/ovpi_timer stop 

—	 Sun: sh /etc/init.d/ovpi_timer stop 
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3 Insert the report pack CD in the CD-ROM drive.


Windows: The Main Menu opens automatically.


UNIX:


a Mount the CD (if the CD does not mount automatically). 

b Navigate to the top level directory on the CD. 

c Run ./setup 

4 Type 1 in the choice field and press Enter. 

The install script displays a percentage complete bar. When the copy is complete, the 
install script starts Package Manager. The Package Manager welcome window opens. 

Task 2: Upgrade to Common Property Tables 3.70 

The Frame Relay Report Pack requires Common Property Tables. If you are running an 
earlier release of Common Property Tables, upgrade to the latest release by installing the 
upgrade package. When you install the upgrade package, do not install other packages at the 
same time. If you need help with the upgrade, refer to the Common Property Tables User 
Guide. If you are not running any version of Common Property Tables, skip this task. Package 
Manager will install Common Property Tables for you, automatically. 

Task 3: Install Frame Relay and at least one datapipe 

1 Start Package Manager. The Package Manager Welcome window opens.


2 Click Next. The Package Location window opens.


3 Click Install. Approve the default installation directory or select a different directory if 

necessary. 

4 Click Next. The Report Deployment window opens. Type your username and password for 
the PI Application Server. 

5 Click Next. The Package Selection window opens. 

6 Click the check box for the following packages: 

• FrameRelay_Service 4.20 

• At least one of the following datapipes: 

— Ascend_FR_Datapipe 

— FRSCPE_Datapipe 

— Newbridge_FR_Datapipe 

— Stratacom_FR_Datapipe 

• FrameRelay_Service_Thresholds (optional) 

7 Click Next. The Type Discovery window opens. To run Type Discovery immediately after 
package installation, accept the default. 

8 Click Next. The Selection Summary window opens. 

9 Click Install. The Installation Progress window opens. When installation is complete, a 
package install complete message appears. 

10 Click Done to return to the Management Console. 
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Task 4: If desired, de-activate port polling policies 

If your PI server is running raw collections for the Interface Reporting Report Pack (you 
installed the IR ifEntry Datapipe when you installed Interface Reporting), you will poll port 
statistics twice, once for Interface Reporting and once for Frame Relay. To avoid polling port 
collections twice, use Polling Policy Manager to disable the collections for frame relay ports. If 
you disable the collections for frame relay ports, consider undeploying the reports in the ports 
folder, since these reports will be empty anyway. 

Task 5: To verify collections, adjust the polling interval 

To see polling results as soon as possible, use Polling Policy Manager to temporarily drop the 
polling interval. Verify that data is being collected by viewing the last key tables (which you 
may want to truncate first) or the datapipe rate tables. After confirming that collections are 
working as expected, reset polling to the recommended interval. 

Task 6: Restart OVPI Timer and start polling 

On Windows: 

1	 Select Control Panel > Administrative Tools > Services 

2 Select OVPI Timer from the list of services.


3 From the Action menu, select Start.


On UNIX, as root, do one of the following:


•	 HP-UX: sh /sbin/init.d/ovpi_timer start 

• Sun: sh /etc/init.d/ovpi_timer start


After one or two polls you will see entries in the DLCI property table, K_frswitch_pvc.


Task 7: Provision CIRs into the DLCIs 

Bandwidth utilization cannot be calculated without a value for committed information rate 
(CIR). Unfortunately, many routers to not provide a CIR value. This means that you have to 
set CIR values yourself. There are several ways to do this: 

•	 From the Management Console, open the Change PVC Configuration form and use the 
form to set CIR values manually. (Be sure to set the console “view” to the Frame Relay 
PVC Endpoints view. If you don’t set the view this way, you will not see the form in the 
Object Specific Tasks frame.) The form works one DLCI at a time, and one device at a 
time. You cannot apply the same CIR to multiple DLCIs or multiple devices. 

•	 Use property import. Export a list of all DLCIs from PI, set CIR values in the file, then let 
PI import the file. 

•	 Use an SQL query to mass-provision all DLCIs to a single value. For example: 

K_frswitch_pvc set CIR = 256000 where dsi_key_id > 0 

•	 Create a custom form to perform mass-provisioning. 

There are service providers who do not use CIRs, in which case the CIR will 
always be zero. If this happens, you should set the CIR equal to the physical port 
speed. You can do this using a form or an SQL query 

Task 8: If necessary, override the customer and location inherited from the interface 

DLCIs inherit customer and location from the parent interface. If you wish to override these 
values on a per-DLCI basis, you may do so using the normal provisioning methods. 
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Task 9: Export property data from PI for safekeeping 

Now is a good time to export property information from PI. If for any reason you need to 
uninstall and reinstall the Frame Relay Report Pack, you can use the export file to 
immediately re-import property information. 

Accessing Deployed Reports 

When you installed Frame Relay, you enabled the Deploy Reports option. As a result, the 
reports in this package (as well as any forms that come with the package) were deployed to 
the PI Application Server. Once reports reside on the PI Application Server, you have two 
ways to view them: 

• PI client applications 

• Web browser 

If you have the client applications on your system, you have access to Report Viewer, Report 
Builder, and the Management Console. If you don’t have the client applications, using a web 
browser to view reports is the only way you can view reports. 

For more information about the clients, see the PI Installation Guide. For more information 
about the Management Console, including how to use the Object/Property Management view 
to launch reports specific to a selected object, see the PI Administration Guide. 

New Objects in the Object Model 

Any item that appears in a report accompanied by performance data or property information 
is an object. Devices, customers, and locations are objects that belong to PI’s default object 
model. When you select an object in the object model, the right side of the Object/Property 
Management window refreshes, showing a list of forms under General Tasks, a list of forms 
under Object Specific Tasks, and a list of reports under Object Specific Reports. 

The object tree changes each time you install a new report pack. Installing Interface 
Reporting adds interfaces as objects under devices. In addition to adding new objects, some 
report packs add an entirely new class of objects or services. When this happens, the report 
pack creates a new view. To open the new view, select View > Change View. 

Installing Frame Relay adds the following object categories to the object model: 

• Frame Relay Interfaces (interfaces that support frame relay circuits) 

• Frame Relay PVC Endpoints 

Seeing Data in Reports 

Some reports populate with data sooner than others. The first report to populate with data is 
the Near Real Time report. You will begin to see data in this report immediately after the first 
data collection completes. Any report that begins with an analysis of yesterday’s performance 
will need at least one full day’s worth of data before results are viewable. Although you will 
begin to see forecast data soon, within a few days, reliable forecast data will not be available 
for about six weeks, when the initial baseline is complete. 
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Removing Frame Relay 

Follow these steps to uninstall the Frame Relay Report Pack and any datapipe that depends 
on the report pack: 

1 Log in to the system. On UNIX systems, log in as root. 

2 Stop OVPI Timer and wait for processes to terminate.


On Windows, do the following:


a Select Control Panel > Administrative Tools > Services 

b Select OVPI Timer from the list of services.


c From the Action menu, select Stop.


On UNIX, as root, do one of the following:


— HP-UX: sh /sbin/init.d/ovpi_timer stop 

— Sun: sh /etc/init.d/ovpi_timer stop 

3 Open the Management Console; from the Tools menu, select Package Manager. The 
Package Manager welcome window opens.


4 Click Next. The Package Location window opens.


5 Click Uninstall. 

6 Click Next. The Report Undeployment window opens. Keep the defaults.


7 Click Next. The Package Selection window opens.


8 Click the check box next to FrameRelay_Service. Any dependent packages will be selected 

automatically. 

9 Click Next. The Selection Summary window opens. 

10 Click Uninstall. The Progress window opens. When removal is complete, a package removal 
complete message appears.


11 Click Done to return to the Management Console.


12 Restart OVPI Timer.


On Windows, do the following: 

a Select Control Panel > Administrative Tools > Services 

b Select OVPI Timer from the list of services.


c From the Action menu, select Start.


On UNIX, as root, do one of the following:


— HP-UX: sh /sbin/init.d/ovpi_timer start 

— Sun: sh /etc/init.d/ovpi_timer start 
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4 Setting Up a Distributed System

These are the steps to follow when setting up a distributed system: 

•	 Decide whether or not you want local reporting 

•	 Install the right set of packages on each server (a central server that is not polling will not 
need datapipes; the satellite servers will need datapipes) 

•	 Verify that the system clocks in your environment are synchronized 

•	 Register your satellite servers 

•	 If you are not copying rate data to the central server, enable LIR on the central server 

•	 If you enable LIR, add LIR mapping with the time type set to rate 

•	 Verify that you have all the copy policies you need 

•	 Configure the central server (manual edits to trendtimer.sched and .pro files) 

•	 Configure each satellite server (manual edits to trendtimer.sched and .pro files) 

If you want to set up a distributed system, you can implement local reporting or you can 
implement centralized reporting. If you want local reporting, you need to deploy reports when 
you install the report pack on each satellite server, and you need to allow summarizations to 
run on each satellite server. If you do not want local reporting, then you do not need to deploy 
reports when you install a report pack on a satellite server and you can disable the scripts 
that run summarizations on each satellite server. 

Before Location Independent Reporting (LIR) was available, our recommendation to anyone 
setting up a distributed system was to deploy reports on satellite servers, keep rate data on 
satellite servers, copy hourly data to the central server, and disable summarizations above the 
hourly level on satellite servers. The advantage to this approach was that it kept a large 
volume of rate data off the network and it decreased the processing load on the central server. 
The disadvantage is that the central server could not display a Near Real Time (NRT) report. 
The only NRT report was a local NRT report, on a satellite server. LIR overcomes this 
disadvantage. If you enable LIR, you can open an NRT report on the central server and 
drill-down on table selections. The selections you make cause the central server to query a 
satellite server for locally aggregated data. Of course, if you would rather copy rate data to the 
central server, you can. If you do that, then enabling LIR is not necessary. 

Several report packs in the October 2007 release include a copy policy enhancement based on 
a copy policy import file. This file contains a list of data tables. When you install a report pack 
that has this file, the core product will generate copy policies automatically. As a result, you 
do not need to use the Managment Console to create copy policies. Instead, your only task 
related to copy policies is to verify that the copy policies you need already exist. 

Because you are likely to have multiple satellite servers, we designed the hourly process files 
to be satellite-server friendly. This means that most of the time, most of the defaults are 
correct. But some defaults will be incorrect, or less than optimal, and to improve performance, 
you should change them. These manual edits, as well as the other steps listed above, are 
spelled out in detail below. 
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Verifying Package Installation 

Before configuring servers, verify that the central server and satellite servers are running the 
correct packages. You want the following packages installed on the central server: 

• Common Property Tables 

• Interface Reporting 

• Frame Relay


You want the following packages installed on each satellite server:


• Common Property Tables 

• Interface Reporting 

• Frame Relay 

• At least one datapipe 

• Frame_Relay_Thresholds (the thresholds sub-package) 

If you do not want local reporting, deploying reports when you install the report pack on a 
satellite server is not necessary. 

Configuring the Central Server 

To configure the central server, perform the following tasks: 

• Task 1: Register the satellite server by setting the database role 

• Task 2: If you are not copying rate data from satellite server, enable LIR 

• Task 3: If you enable LIR, add LIR mappings 

• Task 4: Verify that you have all of the copy policies you want 

• Task 5: Modify the FrameRelay-Switch_trendsum_hourly.pro file 

Task 1: Register the satellite server by setting the database role 

1 Start the Management Console (log on with Administrator privileges).


2 Click the Systems icon in the navigation pane.


3 Navigate to the OVPI Databases folder and select the database system.


4 Click Database Properties. 

5 From the Database Role list, select the Satellite Server role. 

6 Enter any information necessary to configure the Satellite Server role. 

To add a new database reference, you can use the Add Database Reference Wizard in the 
System and Network Administration application. 

Task 2: If you are not copying rate data from satellite servers, enable LIR 

1 Start the Management Console (log on with Administrator privileges). 

2 Click the Systems icon in the navigation pane. 
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3 Navigate to the OVPI Databases folder and select the central server. 

4 Click LIR Configuration. 

5 Select the LIR enabled check box. 

Task 3:	 If you enable LIR, add LIR mappings 

1 Start the Management Console (log on with Administrator privileges). 

2 Click the Systems icon in the navigation pane. 

3 Navigate to the OVPI Databases folder and select the central server. 

4 Click LIR Configuration. 

5 Click Add Mapping. 

6 From the Select Satellite Server list, select a satellite server to which to add a mapping. 

7 Select the Category data table option. 

8 Select FrameRelay from the drop down list. 

9 Select the rate data type. 

10 Click Add to List. 

11 If you want to add additional LIR mappings, click Add to list and repeat step 6 through 
step 10. 

12 Click OK. 

13 Click Apply. 

A copy policy is automatically generated for the hourly data and for each LIR mapping that 
you add. The data type selected when adding an LIR mapping (in step 9 above) determines 
the type of data copied (defined in the generated copy policy).  The type of data copied (defined 
in the generated copy policy) is one greater than the data type selected in the LIR mapping. 
For example, if you select an hourly data type, a daily data copy policy is generated. 

Task 4:	 Verify that you have all of the copy policies you want. 

Verify that a copy policy has been generated for the following tables and that the copy type is 
set correctly (to Property and Data): 

1 Start the Management Console (log on with Administrator privileges). 

2 Click the Copy Policy icon in the navigation pane to start the Copy Policy Manager. 

3 Find the following tables and verify the copy type is set to Property and Data for each 
table: 

• SHfrswitch_pvc 

• SHfrswitch_port


If a copy policy has not been generated for a table, do the following:


1 Click the New Copy Policy icon or select File > New Copy Policy from the Copy Policy 
Manager. The Copy Policy Wizard displays. 

2 Click Next. The Satellite Server and Copy Policy Selection Page displays. 

3 Select a satellite server from the pull down list. This is the satellite server from which 
data is copied to the central server. 

4 Select Single Table and select the table from the pull down list. 
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5 Click Next. The Copy Type Selection Page displays. 

6 Select Property and Data. 

7 Click Next. The Summary page displays. 

8 Verify the information in the summary window. If the information is not correct, you can 
modify it by clicking Back. 

9 Click Finish. 

10 Repeat step 4 - step 9 for all missing tables.


If the copy type is not set to Property and Data, do the following:


1 Double-click the copy policy.


2	 Select the Property and Data copy type. 

3	 Click OK. 

Task 5: Modify the FrameRelay-Switch_trendsum_hourly.pro file 

The FrameRelay-Switch_trendsum_hourly.pro file is found in the 
{DPIPE_HOME}/scripts/ directory where {DPIPE_HOME} is the directory in which PI is 
installed. 

Make the following change to this file: 

•	 Comment out the following line in the pvc_summary block section: 

{DPIPE_HOME}/bin/trend_sum -f {DPIPE_HOME}/scripts/hour_FRS_SHfrswitch_pvc.sum 

•	 Comment out the following line in the port_summary block section: 

{DPIPE_HOME}/bin/trend_sum -f {DPIPE_HOME}/scripts/hour_FRS_SHfrswitch_port.sum 

Configuring a Satellite Server 

Follow these steps to configure a satellite server: 

1	 Modify the {DPIPE_HOME}/lib/trendtimer.sched file (where {DPIPE_HOME} is the 
directory in which PI is installed). 

•	 Find and comment out the following line: 

24:00+4:00 - - {DPIPE_HOME}/bin/trend_proc -f
{DPIPE_HOME}/scripts/FrameRelay-Switch_Daily.pro 

•	 Modify the hourly trendtimer entry. The default is 40 minutes after the hour. Change 
the start time to 25 minutes after the hour (change the start time from 1:00+40 to 
1:00+25). Changing the time prevents the central server from trying to copy data from 
satellite servers just when the satellite servers are beginning their summarizations. 

2 Modify the {DPIPE_HOME}/scripts/FrameRelay-Switch_trendsum_hourly.pro 
file (where {DPIPE_HOME} is the directory in which PI is installed). 

•	 Comment out the following lines in the pvc_summary block section: 

{DPIPE_HOME}/bin/trend_sum -f {DPIPE_HOME}/scripts/
hour_FRS_SHfrswitch_pvc_exec_region.sum 

{DPIPE_HOME}/bin/trend_sum -f {DPIPE_HOME}/scripts/
hour_FRS_SHfrswitch_pvc_exec_region_all_devices.sum 
34	 Chapter 4 



{DPIPE_HOME}/bin/trend_sum -f {DPIPE_HOME}/scripts/
hour_FRS_SHfrswitch_pvc_exec.sum 

{DPIPE_HOME}/bin/trend_sum -f {DPIPE_HOME}/scripts/
hour_FRS_SHfrswitch_pvc_exec_all_devices.sum 

• Comment out the following lines in the port_summary block section: 

{DPIPE_HOME}/bin/trend_sum -f {DPIPE_HOME}/scripts/
hour_FRS_SHfrswitch_port_exec_region_all_devices.sum 

{DPIPE_HOME}/bin/trend_sum -f {DPIPE_HOME}/scripts/
hour_FRS_SHfrswitch_port_exec_region.sum 

{DPIPE_HOME}/bin/trend_sum -f {DPIPE_HOME}/scripts/
hour_FRS_SHfrswitch_port_exec.sum 

{DPIPE_HOME}/bin/trend_sum -f {DPIPE_HOME}/scripts/
hour_FRS_SHfrswitch_port_exec_all_devices.sum 

System Clocks 

Make sure that the system clock on each satellite server is synchronized with the system clock 
on the central server. 
Setting Up a Distributed System 35 



36 Chapter 4 



5 Updating Property Values 

This chapter covers the following topics: 

• Using forms to update properties (including thresholds) for PVCs 

• Using a property import file to update properties (including thresholds) for PVCs 

Forms are context-sensitive. Your location in the object model determines which PVCs will be 
updated by the form. Depending on where you are in the object model, the form may apply to 
one specific PVC, or to a long list of PVCs. No matter which form you are using, the form will 
display a list of the PVCs you are able to update. To modify one PVC, highlight one PVC in the 
list; to modify multiple PVCs at once, highlight multiple PVCs in the list. 

If you have lots of properties to update, using the batch-mode approach (the property import 
file) is probably faster and easier. If you have just a few changes to make, use the forms. 

Using Forms to Update Property Values 

When you install Frame Relay and deploy reports, you also deploy the following forms: 

• Change PVC Endpoint Customer 

• Change PVC Endpoint Location 

• Change PVC Endpoint Description 

• Change PVC Endpoint Configuration 

To launch a form, click the Objects icon on the left side of the Management Console. The 
Object/Property Management view opens. The type of object presented depends on which 
Object Manager View is open: 

• The Device view (the default view) shows a list of devices 

• The Customer view shows a list of customers 

• The Location view shows a list of locations 

To change the view, select View > Change View. Use the pop-up window to select a different 
view. 

When the type of object you want to update appears, select the specific object you want to 
update. Under Object Specific Tasks you will see a list of forms. To open a form, double-click the 
name of the form. 

Change PVC Customer 

Use the Change PVC Customer form to update the customer assigned to one or multiple PVC 
Endpoints. Use the drop down menu to choose a customer. Click Apply to save your changes. 
37 



If you assigned a customer to an interface (using one of the change forms that come with the 
Interface Reporting Report Pack), the PVC endpoints on that interface will inherit the 
customer assigned to the interface. However, if some PVC endpoints already have a different 
customer assigned to them, the customer you assigned to the interface will not be inherited by 
those PVC endpoints. 

Change PVC Location 

Use the Change PVC Location form to update the location assigned to one or multiple PVC 
Endpoints. Use the drop down menu to choose a location. Click Apply to save your changes. 

If you assigned a location to an interface (using one of the change forms that come with the 
Interface Reporting Report Pack), the PVC endpoints on that interface will inherit the 
location assigned to the interface. However, if some PVC endpoints already have a different 
location assigned to them, the location you assigned to the interface will not be inherited by 
those PVC endpoints. 
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Change PVC Description 

Use the Change PVC Description form to update the description of one or multiple PVC 
Endpoints. When the form opens, type your new description in the text entry box. To save 
your changes, click Apply. 
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Change PVC Configuration 

Use the Change PVC Configuration form to update the following property settings for a single 
PVC endpoint: 

• Description 

• CIR 

• PVC Id 

• Customer 

• Location 

• Allowable DE In Deviation (deviation from yesterday’s average) 

• Allowable DE Out Deviation (deviation from yesterday’s average) 

• FECN% Threshold 

• BECN% Threshold


To save your changes, click Apply.
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Using an Import File to Update Property Values 

The same properties you can modify using one of the change forms described in this chapter 
can also be modified using a property import file. You can create this file from scratch, or you 
can export existing property data from PI. If you export existing property values from PI, the 
file exported from PI will be properly formatted. 

Utilization for PVC endpoints cannot be calculated unless CIR values are known. Likewise, 
port utilization cannot be calculated unless ifSpeed is known. If you are collecting these 
values from network elements, and if the values you are collecting are correct, you do not need 
to import correct values. If you are not collecting these values, or if the values you are 
collecting are incorrect, you must import correct values. Use the PVC Configuration Problems 
report to verify whether CIR and PVC Id have been set for all PVC endpoints. 

Exporting Property Data from PI 

If you want to export existing property values from PI, follow these steps: 

1 Navigate to the DPIPE_HOME/scripts directory. 

2 Type: trend_proc -f FrameRelay-Switch_exportdata.pro 

This command calls an PI process that generates a tab-delimited flat file and, if the 
default SourceDirectory has not been changed, stores it in the PropertyData directory 
under FrameRelay_Switch.ap. The tab-delimited flat file has the following name: 

FrameRelay_Switch_PVC_Property.dat.<timestamp> 

3 Edit the tab-delimited file, adding new values or correcting incorrect values.


4 Import the file you just edited.


The export step can take place whenever you want, and as often as you want. 


Importing Property Data into PI 

The import step is actually a scheduled process that executes automatically. It works the 
same way whether you are working with a file you created yourself, or a file that was exported 
from PI and then edited. 

If you want to let the import process run automatically, just make sure that your property 
import file is stored where PI expects to find it. If the default has not been changed, the path 
to the SourceDirectory is: 

{DPIPE_HOME}/data/PropertyData/


PI uses a TEEL file in the DPIPE_HOME/lib directory to locate the property import file. The 
file name is FrameRelay_Switch_PVC_Property.teel. 

The TEEL file must provide the correct SourceDirectory path. The SourceDirectory path may 
have been changed after the Frame Relay Report Pack was installed. 

To run the import process manually, ahead of the scheduled import, do the following: 

1 Navigate to the DPIPE_HOME/scripts directory. 

2 Type: trend_proc -f FrameRelay-Switch_importdata.pro 
42 Chapter 5 

http:FrameRelay_Switch.ap


Adding a New Row or Modifying an Existing Row 

If you intend to modify an existing entry in a property table, the first three columns in the 
import file—Node name, Port and Dlci—must match the values of a row in the property table. 
For example, if your PVC property file includes Node Name = router1; Port value = 1; Dlci = 
23, then there must be an exact match with those values in the KV_frswitch_pvc property 
table. Whenever there is no match between a row in your file and a row in the property table, 
your property import file will add a new row to the property table. 

Formatting the PVC Property Import File 

If you create your own file, you have to either generate the file automatically from a network 
provisioning database, or build the file from scratch using a spreadsheet program. If you 
create your own tab-delimited file, obey these rules: 

•	 Use the formats described below. 

•	 Use all the columns shown in the file format table. 

•	 Use the columns in the order they appear in the table. 

•	 Do not use quotation marks. 

•	 If a cust_id value is already in use for a different customer_name, the existing 
customer_name will not be modified to that which is included in the import file. cust_id is 
the unique field that binds elements to customers. 

•	 If a location_id value is already in use for a different location_name, the existing 
location_name will not be modified to that which is included in the import file. location_id 
is the unique field that binds elements to locations. 

•	 node_name, port, and Dlci columns are the unique identifiers of the property table and 
must contain the same values that exist on the polled PVC. 

•	 If you use a spreadsheet application, export the data from the spreadsheet back into a 
tab-delimited file when you finish. 

•	 If you have a previously generated PVC import file from a Frame Relay version 2.00 
installation, you may use it for your current report pack; the import mechanism will 
convert it to the new format and add the extra columns required. 

The following table describes the format of the PVC property import file. 

Column 

Node name 

Port 

Dlci 

Description 

The device name for the PVC. 
Example: ‘router1’ 

The port name for the PVC. Often the ifIndex value, or the 
unique name of the interface. 
Example: ‘101’ or ‘Serial0/1’. 
You may refer to an interface by the ifIndex during import if you 
do not know the unique identifier being used by the application 
for re-indexing purposes; however, the system will always use the 
unique name for the export procedure. 

The numerical Dlci for this PVC endpoint. 
Example: 123 
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Column 

CIR 

RevCIR 

cust_id 

location_id 

pvc_id 

location_name 

customer_name 

dsi_descr 

FECN Percent 

BECN Percent 

Description 

The Committed Information Rate in bits/second 
The report pack requires this value. Some devices provide it 
directly from the network. Check the PVC Configuration 
Problems report to see if any are not set. 
Example: 64000 

Reverse Committed Information Rate in bits/second.

Example: 64000

Not used in default reports.


Unique integer value for each customer name.

Reserved values include -2 and -1.

Value should always be greater than 0.

Example: 30


Unique integer value for each location name.

Reserved values include -2 and -1.

Value should always be greater than 0.

Example: 30


Unique integer value for a pair of PVC endpoints.

Used to associate PVC endpoints together. Check the PVC 

Configuration Problems report to see if any are not set. The 

default value of -2 indicates that it has not been set.

Example: 55


Location name associated with location_id value.

Example “North London”.

If the associated location_id already exists with a different 

location_name then this value will be discarded. Use the 

Common Properties package to update location_name / 

location_id value pairs.


Customer name associated with cust_id value.

Example “Large Corp 1”.

If associated cust_id already exists with a different 

customer_name then this value will be discarded. Use the 

Common Properties package to update customer_name / cust_id 

value pairs.


A description for the PVC endpoint 
Example A: Service Level 1 
Example B: Failover PVC 

The percentage of packets which can be marked FECN; if this 
percentage is exceeded, a threshold event is generated. 

The percentage of packets which can be marked BECN; if this 
percentage is exceeded, a threshold event is generated. 
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Column 

DE In Deviance 

DE Out Deviance 

Description 

The percentage deviation of packets above yesterday’s average 
DE In packet ratio which is considered within normal limits. A 
ratio of in packets marked DE above the average value yesterday 
+ this percentage will generate a threshold event. 

The percentage deviation of packets above yesterday’s average 
DE Out packet ratio which is considered within normal limits. A 
ratio of out packets marked DE above the average value 
yesterday + this percentage will generate a threshold event. 
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6 PVC Endpoint QuickView 

The PVC Endpoint QuickView, and the Snapshot version of the same report, identifies PVCs 
with high utilization. Use this report to spot PVCs with high utilization and to find out 
whether utilization is primarily egress or primarily ingress. In addition, this report shows 
how utilization relates to congestion notification and frame types. 

There are NRT, daily, and monthly versions of this report. See below for a sample of the Daily 
PVC Endpoint QuickView. The selection table ranks PVCs by utilization and provides values 
for: 

• Ingress utilization 

• Egress utilization 

• Peak ingress utilization 

• Peak egress utilization 

• Busiest ingress hour 

• Busiest egress hour


The hourly graph below the selection table compares: 


• Average ingress utilization to peak ingress utilization


• Average egress utilization to peak egress utilization


The next hourly graph looks at congestion and frame types. Use this graph to compare:


• Average percent of ingress FECN frames to peak percent of FECN frames


• Average percent of ingress BECN frames to peak percent of BECN frames


• Average percent of egress FECN frames to peak percent of FECN frames


• Average percent of egress BECN frames to peak percent of BECN frames


• Average percent of ingress DE frames to peak percent of ingress DE frames


• Average percent of egress DE frames to peak percent of egress DE frames


The Grade of Service bar chart provides an overall score for each hour of the day. The overall 
score combines utilization, frame types, and congestion. The frequency distribution pie charts 
indicate how yesterday’s activity breaks down in terms of the percentage of samples that fall 
into various ranges of utilization. 
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7 Port NRT QuickView

Port QuickView and Port Snapshot reports are available in three time ranges: 

• Daily — showing hourly statistics for the previous day 

• Monthly — showing daily statistics for the previous month 

• Near Real Time — showing averages compiled over the previous six hours. 

Port QuickView and Snapshot reports focus on utilization, discards and errors. The selection 
table at the top performs a ranking function, sorting ports by utilization, highest to lowest. In 
the NRT version of the report (see below), the top selection table provides averages for sample 
data collected during the previous 6 hours. For each port in the table, you can see: 

• In utilization 

• Out utilization 

• Percentage of in errors 

• Percentage of out errors 

• Percentage of in discards 

• Percentage of out discards 

The first graph below the selection table compares in utilization to out utilization. The next 
graph to the right looks at errors and discards. Use the graph on the right to compare in 
errors to out errors, in discards to out discards. 

The bottom graph provides an hourly grade of service score for ingress an egress. The score 
combines: 

• Utilization 

• Errors 

• Discards


Use this graph to see when service moved from the good range into the warning range.
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8 Port Executive Summary

The Port Executive Summary report conveys a clear picture of utilization on a 
customer-by-customer basis. This report aggregates data at the customer level, providing 
monthly, daily and hourly coverage of volume and error counts. What you will not find in this 
report are statistics for specific ports. 

The Port Executive Summary contains one line graph and the following bar charts: 

•	 Monthly volume for all ports — total volume both in and out for all ports associated with 
this customer aggregated for monthly periods. 

•	 Monthly error count for all ports — total error counts both in and out for all ports 
associated with this customer aggregated for monthly periods. 

•	 Daily volume for all ports — total volume both in and out for all ports associated with this 
customer aggregated for daily periods. 

•	 Daily error counts for all ports — total error counts both in and out for all ports associated 
with this customer aggregated for daily periods. 

•	 Hourly volume for all ports — total volume both in and out for all ports associated with 
this customer aggregated for hourly periods. 

•	 Hourly error counts for all ports — total error counts both in and out for all ports 
associated with this customer aggregated for hourly periods. 

The total of in traffic and out traffic may reflect double counting of frames 
when the in and out ports are associated with the same customer. 

As explained in Chapter 4, Package Configuration, you have two ways of assigning a customer 
to a PVC: 

•	 By importing the customer name as property data 

•	 By using a change form 

If a customer is assigned to the parent object of a PVC, the change will trickle down to the 
PVC level, but only if customers have not been set yet. For example, assume a device has 10 
interfaces, and each interface has 2 PVCs on it. If you assign Customer A to PVC 1 on 
Interface 1 and Customer B to the device itself, the results we be as follows: Every PVC on the 
device will belong to Customer B except PVC 1 on Interface 1. 
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9 PVC Endpoint Availability 

The availability report allows you to focus on PVCs and ports that have been unavailable for 
any reason. In this context, an unavailable PVC is a PVC that is out of operation. Scheduled 
maintenance as well as failures will take ports and PVCs out of operation. 

Availability is measured as a percentage of time over the time period that the port or PVC was 
considered to be operational—based on metrics such as ifOperStatus, sysUpTime, 
ifLastChange, and Circuit State—on the device. 

The selection tables list PVC endpoints that had less than 100% availability over the day or 
month, while the hourly and daily bar graphs illustrate when the problems happened and for 
how long. Each bar in the hourly chart represents one hour in a 24 hour period. Each bar in 
the daily chart represents one day in the previous month. 
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10 PVC Endpoint Top 10

There are two Top Ten reports, one for ports and one for PVCs. Each provides a list of the top 
ten elements sorted by average utilization over the time period. The daily section of the report 
looks at statistics for the previous day; the monthly section looks at statistics for the previous 
calendar month. 

The first selection table in the PVC Endpoint report looks at average and peak utilization 
levels for yesterday. It provides a list, ranked in descending order, of the ten PVC endpoints 
that reported highest average utilization in either direction, In or Out. In addition to listing 
the PVC endpoint and CIR, this table indicates utilization values for: 

• Average In 

• Average Out 

• Peak In 

• Peak Out 

Selecting an endpoint from the list displays additional information about the device itself and 
the customer and locations associated with the PVC endpoint. 
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11 PVC Endpoin t Forecas t

The PVC Endpoint Forecast focuses on growth rates. The growth rate for utilization is 
calculated by projecting utilization 30 days into the future and dividing the increase by the 
current baseline average for that day of the week. The higher the difference between the 
current average and the projected value, the greater the rate of growth. Use this report to 
identify problems long before they become critical. 

Each row in the selection table describes one PVC endpoint. The endpoints are sorted in 
descending order by rate of growth. In addition to listing endpoints in growth-rate order, this 
table indicates: 

•	 Day of week 

•	 Projected in utilization 30 days into the future 

•	 Baseline utilization 

•	 Projected out utilization 30 days into the future 

•	 In ratio of growth 

•	 Out ratio of growth 

When you highlight an endpoint in the selection table, the following data appears in the 
tabbed area. 

•	 Basic: Compares in and out average utilization for the day to the busy hour utilization for 
the day. 

•	 In Util Standard: Compares IN utilization to median IN utilization. The tab shows the 
baseline, the median, baseline utilization -1 standard deviation, and baseline utilization 
+1 standard deviation. 

•	 Out Util Standard: Compares OUT utilization to median OUT utilization. The tab shows 
the baseline, the median, baseline utilization -1 standard deviation, and baseline 
utilization +1 standard deviation. 

•	 In Util Advanced: Compares baseline IN utilization to forecasted IN utilization 30, 60 and 
90 day into the future. The date at the bottom of the tab represents the start date that the 
forecast calculation data is taken from. 

•	 Out Util Advanced: Compares baseline OUT utilization to forecasted OUT utilization 30, 
60, and 90 days into the future. The date at the bottom of the tab represents the start date 
that the forecast calculation data is taken from. 
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12 PVC Configuration Problems

The PVC Configuration Problems report provides an inventory of: 

• PVC Endpoints with no CIR setting 

• PVC Endpoints with no PVC Id setting 

Invalid CIR Settings 

Many Frame Relay reports calculate utilization. These calculations rely on valid CIR values. 
If the CIR value is not valid, the calculation will fail. If the RFC1315 MIB table or the Cisco 
Frame Relay MIB table provides a CIR of 0 bits per second, errors will occur when PI 
attempts to calculate utilization. These errors will cause rows of data to disappear from 
selection tables. To avoid this problem, you must re-set the CIR. One of your options is to set 
the CIR equal to the full ifSpeed of the interface that the PVC terminates on. This speed is 
equal to the maximum bandwidth available to the PVC. 

If invalid CIR values are being sourced from either the RFC1315 MIB or the Cisco Frame 
Relay MIB, you have to ways to set valid values: 

• By editing a property import file, and letting PI import the file 

• By using a change form 

Invalid PVC Id 

The PVC Id is an integer value associated with the two ends of a single PVC. When a PVC Id 
for each PVC Endpoint is not available, most reports are not affected, however, the 
End-to-End reports will be affected. Populating this field is recommended, but not mandatory. 

There are two ways to update PVC Id values: 

• By editing a property import file, and letting PI import the file 

• By using a change form 

See Chapter 5, Updating Property Values, for more information about importing property 
information, including CIR and PVC Id. 
69 



Chapter 12
70 



A Version History 

Version Release Date Features/Enhancements 

1.00 January 2002 Sybase support 
datapipes: 
• Frame Relay CPE Datapipe 1.00 
• Ascend Frame Relay Datapipe 1.00 
• Newbridge Frame Relay Datapipe 1.00 
• Stratacom FR Datapipe 1.00 (Cisco WAN) 

2.00 January 2003 new upgrade package: 
UPGRADE_FRS_1.0_to_2.0 

3.00 October 2003 new feature: 
PI Object Manager support 
new upgrade package: 
UPGRADE_FRS_2.x_to_3.0 
new change forms: 
• Change PVC Endpoint Customer 
• Change PVC Endpoint Location 
• Change PVC Endpoint Description 
• Change PVC Endpoint Configuration 

4.00 April 2004 new feature: 
Oracle support 
new upgrade package: 
UPGRADE_FRS_3.0_to_4.0 

4.10 April 2007 new features: 
• Supports Management Console > LIR Configuration 

• Supports Management Console > Copy Policy Manager 

• Rate data removed from NRT reports, top table 
• Object delete 
new versions of the datapipes: 
• Ascend FR Datapipe 4.10 
• Newbridge FR Datapipe 4.10 
• Stratacom FR Datapipe 4.10 
• FRSCPE Datapipe 4.30 
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Version Release Date Features/Enhancements 

4.10 April 2007 new upgrade package: 
• UPGRADE_FRS_30_to_41 
defect fixes: 
• QXCR1000221968 
• QXCR1000278852 

4.20 October 2007 new feature: 
• Copy Policy Enhancement 
defect fixes: 
• TBD 
• TBD 
• TBD 

4.20  February 2009 new upgrade package: 
• FrameRelay_Service_Upgrade_30_to_42 
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B Editing Tables and Graphs

Any table or graph can be viewed in several ways. Although the default view is usually 
adequate, you can easily change to a different view. If you are using Report Viewer, right-click 
the object to open a list of view options. If you are using the Web Access Server, follow these 
steps to change the default view of a table or graph: 

1 Click Preferences on the links bar. 

2 Expand Reports in the navigation frame. 

3 Click Viewing. 

4 Select the Allow element editing box. 

5 Click Apply. 

6 Click the Edit icon next to the table or graph. 

View Options for Tables 

Right-clicking a table, or selecting the Edit Table icon if you are using the Web Access Server, 
opens a list of table view options. 

Select Set Time Period to alter the relative time period (relative to now) or set an absolute time 
period. The Set Time Period window opens. 

You may shorten the period of time covered by the table from, for example, 42 days to 30 days 
or to 7 days. If you are interested in a specific period of time that starts in the past and stops 
before yesterday, click Use Absolute Time and select a Start Time and an End Time. 

Select Change Constraint Values to loosen or tighten a constraint, thereby raising or lowering 
the number of elements that conform to the constraint. The Change Constraint Values 
window opens. To loosen a constraint, set the value lower; to tighten a constraint, set the 
value higher. 

The Select Nodes/Interfaces allows you to change the scope of the table by limiting the table to 
specific nodes, specific interfaces, or a specific group of nodes or interfaces. The Select Node 
Selection Type window opens. 
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Change Max Rows increases or decreases the number of rows in a table. The default is 50. If 
you expand the default, the table may take more time to open. If you are trending a large 
network, using the default ensures that the table opens as quickly as possible. 
View in new Frame opens the table in a Table Viewer window, shown below. If necessary, make 
the data in the table more legible by resizing the window. 

View Options for Graphs 

Right-clicking a graph, or clicking the Edit Graph icon if you are using the Web Access Server, 
opens the following list of view options. 
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The following table provides details about each option. 

Option 

Set Time Period 

Change Constraint Values 

Select Nodes/Interfaces 

Displayed Data 

Grid 

Legend 

Style 

Change Max Rows... 

Display Data Table 

Export Element as CSV... 

View in New Frame 

Print Graph 

Function 

Same as the table option shown above. 

Same as the table option shown above. 

Same as the table option shown above. 

For every point on a graph, display data in a 
spreadsheet. 

Add these to the graph: 
X axis grid lines 
Y axis grid lines 
X and Y axis grid lines 

Delete or reposition the legend. 

See the illustrations below. 

Same as the table option shown above. 

See below. 

Same as the table option shown above. 

Opens graph in a Graph Viewer window. 

Same as the table option shown above. 

Style Options 

Select Style to display a list of seven view options for graphs. 
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Style > Area 

The plot or bar chart changes to an area graph. While relative values and total values are 
easy to view in this format, absolute values for smaller data types may be hard to see. Click 
anywhere within a band of color to display the exact value for that location 

To shorten the time span of a graph, press SHIFT+ALT and use the left mouse button to 
highlight the time span you want to focus on. Release the mouse button to display the selected 
time span. 

Style > Stacking Area 

The area or plot graph changes to a stacking area graph. This view is suitable for displaying a 
small number of variables. 
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Style > Bar 

The graph changes to a bar chart. This view is suitable for displaying relatively equal values 
for a small number of variables. There are three variables in the graph below. 

Style > Stacking Bar 

The plot or area graph changes to a stacking bar chart. If you increase the width of the frame, 
the time scale becomes hourly. If you increase the height of the frame, the call volume shows 
in units of ten. 
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Style > Plot 

Bands of color in an area graph change to lines. If you adjust the frame width, you can make 
the data points align with hour; if you adjust the frame height, you can turn call volume into 
whole numbers. 

Style > Pie 

An area graph becomes a pie chart. Bands in an area graph convert to slices of a pie and the 
pie constitutes a 24-hour period. This view is helpful when a small number of data values are 
represented and you are looking at data for one day. 

If you are looking at data for more than one day, you will see multiple pie graphs, one for each 
day. 
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Display Data Table 

This option changes a graph into a spreadsheet. 

View in New Frame 

The graph opens in a Graph Viewer window. Improve legibility by resizing the window. 
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Glossary

Backward Explicit Congestion Notification (BECN) 

A specific bit in the header of the frame relay packet; also, a method for preventing a 
congested condition from getting worse. If a node becomes congested, changing the value of 
the BECN bit to 1 signals congestion to the upstream node and attached user devices. 

Busy Hour 

The definition varies depending on what is being measured. Busy hour is either a busy hour 
total, or a busy hour average. A busy hour total points to the hour of the day that recorded the 
highest number of events, for example, the highest number of discards or the highest number 
of errors. A busy hour average points to the hour of the day when the average of multiple 
samples was highest (in the case of utilization) or lowest (in the case of throughput). Busy 
hour is a persistent event and should not be confused with peak, which could be very brief. If 
the value for busy hour seems high, keep in mind that actual utilization during the course of 
that hour may have been significantly higher. 

Congestion 

The point at which the network cannot keep up with entering traffic and begins flow control. 
The network reaches severe congestion when an increase in the number of retransmissions 
begins to lower actual effective throughput. To recover from this condition, the network 
notifies end devices to reduce traffic. 

Committed Information Rate (CIR) 

The rate at which the ingress interface and the egress interface transfers information to a 
destination under normal conditions. 

Data Link Connection Identifier (DLCI) 

A number inside the header of a frame relay packet that identifies a virtual circuit 
corresponding to a particular destination. 

DE frames 

Number of frames eligible for discard. A DE frame is created when the remote DTE sets the 
DE flag. 

Discards 

The number of frames that were discarded. Higher level protocols detect discarded frames 
and request a retransmission. 

Discard Eligibility 

A specific bit in the header of a frame relay packet; also, a mechanism for identifying which 
frames should be discarded if the network becomes overloaded. When a CPE device or a 
network switch sets the DE bit to 1, the frame is above the Committed Information Rate (CIR) 
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and therefore eligible for discard if congestion arises. A frame with a DE set to 1 will be 
discarded before non-discard eligible frames. 

Errors 

The number of frames that were discarded because of errors. The following conditions are 
considered errors and will cause the frame to be discarded: (1) the frame was too long, (2) the 
frame was too short, (3) the DLCI value was invalid or unrecognized, (4) a value in the header 
was incorrect. 

Forward Explicit Error Notification (FECN) 

A specific bit in the header of the frame relay packet; also, a method for preventing a 
congested condition from getting worse. If a node becomes congested, it can set the value of 
the FECN bit to 1, thereby signally congestion to the downstream node and attached user 
devices. 

Frame Types 

There are three types of frames: unmarked frames, frames marked Discard Eligible (DE), and 
frames marked ODE. Frame types are color-coded. Unmarked frames are green; DE frames 
are amber, and ODE frames are red. Because most switch vendors do not mark frames ODE, 
your reports will not show statistics for red frames unless your switch vendor supports ODE. 

Frequency Distribution 

QuickView and Snapshot reports include frequency distribution pie charts that show the 
percentage of samples falling within a specific ingress/egress or in/out utilization range for 
each hour of yesterday, or each day over the course of the last thirty days. The ingress and 
egress ranges for PVC endpoint utilization are: 

0 - 80%


80 - 90%


90 - 100%


> 100%


The in and out ranges for port utilization are:


0 - 50%


50 - 60%


60 -70%


70 - 100%


Grade of Service 

Quickview, Snapshot, and Hot Spots include Grade of Service charts. A Grade of Service is a 
ranking derived from a weighted average. The following table explains the grading behind 
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scores for PVC endpoints. It shows the metrics the grade is based on, the weighting factor 
assigned to each metric, and the performance parameters for each of four possible grades. 

GRADE 
CALCULATION 

AVERAGE 
UTILIZATION 

AVERAGE 
PERCENT RED 
AND/OR AMBER 
FRAMES 

AVERAGE 
PERCENT 
CONGESTION 

Weighting 60% 20% 20% 

Excellent Range 0 - 80% 0 - 5% 0 - 5% 

Good Range 80 - 90% 5 - 7% 5 - 7% 

Warning Range 90 - 100% 7 - 10% 7 - 10% 

Critical Range Over 100% Over 10% Over 10% 

The following table explains the grading behind scores for ports. It shows the metrics the 
score is based on, the weighting factor assigned to each metric, and the parameters for each of 
four possible grades. 

GRADE 
CALCULATION 

AVERAGE 
UTILIZATION 

AVERAGE 
PERCENT RED 
AND/OR AMBER 
FRAMES 

AVERAGE 
PERCENT 
CONGESTION 

Weighting 60% 20% 20% 

Excellent Range 0 - 50% 0 - 5% 0 - 5% 

Good Range 50 - 60% 5 - 7% 5 - 7% 

Warning Range 60 - 70% 7 - 10% 7 - 10% 

Critical Range Over 70% Over 10% Over 10% 

Near Real Time (NRT) 

A report containing a rolling average for performance over the last six hours. The most recent 
data in this report was collected by the most recent poll, which probably took place within the 
last 15 minutes. 

Peak 

The highest of several samples (typically, the highest of four samples if polling is taking place 
every 15 minutes) recorded over an hour. Each hour produces one peak. 

Port 

Any frame relay interface on any network device that supports MIB-II. 

Permanent Virtual Circuit (PVC) 

A fixed path not available on demand or on a call-by-call basis. The location of the beginning 
and the end of the circuit do not change, although the actual path taken through the network 
may vary if automatic rerouting takes place. 
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PVC Endpoint 

The logical end point for a circuit. Typically this is defined by a combination of the device 
name, the MIB-II interface name and the Dlci number. 

Utilization 

Calculated at a PVC Endpoint by dividing the actual traffic on the circuit by the Committed 
Information Rate. Calculated at the Port or interface level by dividing traffic counts by the 
ifSpeed of the Port. 
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grid options, 75
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group filters, 14
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Port Executive Summary report, 55


Port NRT reports, 51


port polling policies, 12, 27
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location of, 42
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PVC, defined, 83


PVC directory, 10


PVC Endpoint, defined, 84
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customizing, 13
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PVC Endpoint Availability, 59
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Top Ten, 61


RFC 1315, 12
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configuring, 34


servers

configuring, 34
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SourceDirectory path, 42


Stratacom Frame Relay Datapipe, 17, 23


style options for graphs, 75


synchronizing system clocks, 35
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thresholds sub-package, 24
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uninstall
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upgrade

Common Property Tables, 20, 26
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version 2.00, 71
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We appreciate your feedback! 

If an email client is configured on this system, by default an email window opens when you 
click on the bookmark “Comments”. 

In case you do not have the email client configured, copy the information below to a web mail 
client, and send this email to docfeedback@hp.com 
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Document title:


Version number:


Feedback:


mailto:docfeedback@hp.com





	User Guide
	Contents
	1 Overview
	PI and Frame Relay Interfaces
	Enhancements in Version 4.20
	Generic Reports
	Data Collection
	The Requirement for Interface Reporting
	Double-Polling Port Statistics
	Integration with NNM

	Ways to Customize Reports
	Group Filters
	Applying Constraints

	Sources for Additional Information

	2 Upgrading the Report Pack
	Guidelines for a Smooth Upgrade
	Software Prerequisites
	Common Property Tables
	Datapipes and Remote Pollers
	Exporting Polling Policy Configurations
	Exporting Polling Group Configurations

	Custom Table Views
	Distributed Environments

	Upgrading to Frame Relay 4.20
	Post-Upgrade Steps

	3 Installing the Report Pack
	Guidelines for a Smooth Installation
	Software Prerequisites
	Interface Reporting Report Pack
	Preprocessors for Vendor-Specific Datapipes

	Common Property Tables
	FrameRelay_Service_Thresholds
	Distributed Environments

	Installing and Tuning Frame Relay
	Accessing Deployed Reports
	New Objects in the Object Model
	Seeing Data in Reports

	Removing Frame Relay

	4 Setting Up a Distributed System
	Verifying Package Installation
	Configuring the Central Server
	Configuring a Satellite Server
	System Clocks

	5 Updating Property Values
	Using Forms to Update Property Values
	Change PVC Customer
	Change PVC Location
	Change PVC Description
	Change PVC Configuration

	Using an Import File to Update Property Values
	Exporting Property Data from PI
	Importing Property Data into PI
	Adding a New Row or Modifying an Existing Row
	Formatting the PVC Property Import File


	6 PVC Endpoint QuickView
	7 Port NRT QuickView
	8 Port Executive Summary
	9 PVC Endpoint Availability
	10 PVC Endpoint Top 10
	11 PVC Endpoint Forecast
	12 PVC Configuration Problems
	Invalid CIR Settings
	Invalid PVC Id

	A Version History
	B Editing Tables and Graphs
	View Options for Tables
	View Options for Graphs
	Style Options
	Style > Area
	Style > Stacking Area
	Style > Bar
	Style > Stacking Bar
	Style > Plot
	Style > Pie

	Display Data Table
	View in New Frame


	Glossary
	Index

	We appreciate your feedback!
	Comments



<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (None)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.5
  /CompressObjects /Off
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.1000
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 524288
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments true
  /PreserveOverprintSettings false
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Preserve
  /UCRandBGInfo /Preserve
  /UsePrologue true
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
    /Courier
    /Courier-Bold
    /Courier-BoldOblique
    /CourierNewPS-BoldItalicMT
    /CourierNewPS-BoldMT
    /CourierNewPS-ItalicMT
    /CourierNewPSMT
    /Courier-Oblique
    /Futura-Bold
    /Futura-Book
    /Futura-BookItalic
    /Futura-Heavy
    /Futura-Light
    /Futura-Medium
    /Futura-MediumItalic
    /Garamond
    /Garamond-Bold
    /Garamond-Italic
    /Helvetica
    /Helvetica-Bold
    /Helvetica-BoldOblique
    /Helvetica-Narrow
    /Helvetica-Narrow-Bold
    /Helvetica-Narrow-BoldOblique
    /Helvetica-Narrow-Oblique
    /Helvetica-Oblique
    /NewCenturySchlbk-Bold
    /NewCenturySchlbk-BoldItalic
    /NewCenturySchlbk-Italic
    /NewCenturySchlbk-Roman
    /Symbol
    /SymbolMT
    /Times-Bold
    /Times-BoldItalic
    /Times-Italic
    /Times-Roman
    /Webdings
    /Wingdings2
    /Wingdings3
    /Wingdings-Regular
    /ZapfDingbats
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 150
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 150
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /ColorImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 150
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 150
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /GrayImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 600
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects true
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile (None)
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName (http://www.color.org)
  /PDFXTrapped /False

  /SyntheticBoldness 1.000000
  /Description <<
    /ENU ()
  >>
>> setdistillerparams
<<
  /HWResolution [600 600]
  /PageSize [612.000 792.000]
>> setpagedevice




